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Do not open the Seal of the Question Booklet until you are ;s—ke—@
tion Booklet Code: ' —
SE ode B Question Booklet Series No: ‘ 1334 02

Time Allowed: 2 Hours Total Questions: 150 Maximum Marks: 150
There shall be negative marking @ 0.25 marks per question for wrong/multiple answers

Bgfore answgring any question, check the booklet that it contains 16 pages and no page is
missing, mutilated or repeated. In case of defect, get it replaced immediately.

V/ INSTRUCTIONS FOR CANDIDATES

1 Fill in the OMR answer sheet, mentioning the Roll No. and other data as required in the
place(s) indicated therein. Darken the appropriate circles in blue or black ball point pen only.
Do not write any name / surname or put any symbol, sign, slogan, prayer or any mark of
identification in the OMR answer sheet. Do not tamper with the bar-code or any other portion
of the OMR answer sheet. Any such act is liable to render the answer sheet unfit for

evaluation.

2. Correcting fluid, eraser, blade, books, textual material, script notes / loose paper, calculator,
document, slide rules, log tables / electronic watches, smart watch, cell phone, pager, other

electricall electronic devices etc, are not allowed inside the examination hall. In case the

candidate is found to be in possession of any of the above, he / she shall be expelled from E

the examination without any enquiry as to whether the same was / were used by the S
candidate or not.

3. A machine will read the coded information furnished by you in the OMR Answer Sheet. If
the information so furnished by you is incomplete or different from what you have given in
the application form, you shall be awarded Zero mark.

4. Answer must be given by completely darkening one of the four circles | ovals representing
the most appropriate answer given on the Answer Sheet corresponding to the relevant
question. For answers not shown by properly darkening in black / blue ball point pen, no

marks shall be awarded.
5. No Rough work should be done on the OMR Answer Sheet, Space for rough work has been

provided in the Question Booklet itself. ,
6. After the examination is over, candidates must ensure to fold the OMR Answer Sheet at the
perforation and separate the Original Copy and Candidate’s Copy of the Two Part OMR
Answer Sheet in the presence of the Invigilator and handover the Original Copy to the
Invigilator. The Candidate’s Copy of the OMR Answer sheet may be taken by the candidate.
Failure to hand over the original copy of the OMR Answer Sheet to the Invigilator before
leaving the examination hall / room shall make the candidate liable for penal action.

7. Candidates may take with-them the respective question-booklet after the examination is

over.
8. Failure to comply with or violation of any of the above instructions shall be considered as
adopting unfair means and action as deemed proper shall be taken.
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Data Interpretation

(Q.1-3) The following table shows the .
percentage profit (%) earned by two companies
A and B during the years 2011-2015. Answer
the questions based on the data contained in
the table. -

| Profit Earned by Two Companies

|

'{ Year }' Percentage profit % \

A B |

l\ 2011 \ 20 30 B

‘l 2012 \ 35 40 |

2013 a5 | 3B |
2014 40 | U

2015 25 \ 35 |

1. If the total expenditure of two companies
was Rs 9 Lakh in the year 2012 and the
expenditure of A and B were in the ratio
2:1, then what was the income of the
company A in that year?

a) Rs. 9.2 Lakh LD ;\b
bYRs. 8.1 Lakh [ oy -
c) Rs 7.2 Lakh

L A

What is the average percentage profit
earned by the company B?

d) Rs. 6.0 Lakh

a) 35% KOG X vycé
b) 42% %
9 38% o

d) 40%

3. In which year, the percentage profit

earned by the company B is less than
that of company A?

a) 2012

by2013
c) 2014

d) 2015

(Q.4-6) Answer following questions based on
the data contained in the table.

Sales Revenue (Rs. in Lakh)

ltems /Years 2012 2013 2014 | 2015

| Journals 46 47 45 a4

| Magazines 31 39 46 | 51
Books 73 77 78 78 .
Total 150 163 169 173—\

4. Lnt2?1 S, approximately What Perce
otal revenuye came from Mot
\ &) 459, bOC\)}i(S?
b) 559, M
c) 359 4 4
d) 25% X
2. Thg number of Years in which there
an increase in revenue from at Ieastt\?\,
Categories of items, is: ’
a) 0
b) 1
e) 2
d) 3
6.

If the year 2016 shows the same growth
in terms of total sales revenue as the
year 2015 over the year 2014, then the

revenue in the year 2016 must be
approximately:

a) Rs. 194 Lakh Y7
b) Rs.187Lakh Yo"\
c) Rs. 172 Lakh b

AN
@V Rs. 177 Lakh

(Q. 7-11) Read the following graph and answer
the questions.

Trade Deficit of Country (in Rs. Crore)

7. The deficit in 1993-94 was roughly how
many times the deficit in 1990-917

a) 14 3
LQ)/T.S 2
c) 25 V} *
d) 0.5 yg@

jsTn/Ene/®’
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8. Percentage increase in deficit in 1993-94

as compare to deficit in 1989-90 was:
a) 200

)
b) 150 W
€ 100 N
d) 2100 2

9. Inwhich of the following years, the

percent increase of deficit was highest A\
over its preceding year? 2

a) 199293 — |0 3[\ W

DY1990-91 - g \\q o
o) 1993-94 0 Nof
d) 1988-89 A

&

10. The ratio of the number of years, in
which the trade deficit is above the
average deficit, to those years in which

the trade deficit is below the average
deficit is:

e - o0 @
b) 5:3 > V% ¥
c) 4:4 2 %
d) 3:4

11. The deficit in 1992-93 was approximately
how many percent of the average

12. The speed of the car is:

x\’o
a) 12 km/h WA
\b)6 km/h ™ A2 \
18 km/h L= 2
d) 24 km/h g

13.The speed of the car (in m/min) is:
) 60

S/\O/%L\
4
\y/ 100
) 600

76
WS
m%
d) 1000

14.The distance travelled by the carin 4.5
hour is:
7 km
30 km
36 km
d) 40 km
15.The car covers a distance of 15 km in:
a) 3h
b) 2h
c) 1.5h
2.5h

b)
)

(Q. 16-20) Read the following pie chart carefully
and answer the following questions.

Percent wise distribution of students in six

courses in a university "\'7:
s SO e
b) 140 }X/@ Fo i (o
c)y124 ST M.B.A 17% = -
gl % = B.A 24% Y
d) 40 24
(Q. 12-15) The graph given here shows M Tech 7% 03
a car following the linear path with BTech 11% \'/< |
uniform speed. Study the graph and — MSc sk %}’}
answer the questions. RS 7%
Y — o} | | 1o, [
1 M " 4,24 %’ ‘
7 I
S 15 [a12] —~
€ 10 Total number of Students=11200
8 5+ - $6/Number of students in B.Tech course is
0 i 5 3 v A s ' approximately, what percent more than
Time (in hours) > the number of students in M.Tech_ |
course? ’

|
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"
y a) 57%
b) 43%
c) 149%
d) 143%
17.1f 25% of the total number of students in
B.A course is girls, then the number of

boys in B.A course is exactly equal to
the number of students of which course?

ay'M.Sc k

vy
b) B.Sc M%
o B.Tech >/
d) MBA

18.What is the difference between the total
number of students in M.Sc, B.Tech and
M.B.A together and the total number of
students in B.Sc, M.Tech and B.A
together? ~
a) 874 A
\b) 896

19.What is the average number of students
in B.Tech, M.Tech and B.A course
166 0.1
together?

y\ a) 1648 N

\
b) 1542 )/\\\@

AY)
\©)1568 N
d) 1668 4 <

\7
20.Number of students in M.B.A course is

approximately, what percg@gﬁﬁeiétal

| number of students in M.Sc and B.Sc
“ together?

J
/
a) 54% \'}, ')
b) 48%

(Q. 21-25) Study the following information
carefully to answer the questions.

In a school having 400 Students, boys
and girls are in the ratio of 3:5. The students
speak Hindi, English or both the languages.

. 07\5 \ %/ Y
c) 884 R
d) 894 ‘ X . Qé(

R \ R
1% A

64

v\@ﬁ: ¥
12% of boys speak only Hindi, 22% of the gjris @

speak only English, 24% of the tota| studgy,
speak only Hindi and the number of boys :
speaking both the languages is Six timeg
number of boys speaking only Hindi.

21.How many boys speak Hindj?
L2y’ 18
b) 126
c) 108
d) 26
22.How many girls speak only Hingj?
a) 55 '
b) 117
c) 96
d) 78
23.How many students speak English?
a) 304
b) 79
c) 225
d) 117
24.The number of girls speaking only Hingi
is what percent of total number of
students speaking only Hindi?
a) 38.2%
b) 71.8%
c) 81.25%
d) 78%
25.What is the ratio of the number of boys

to the number of girls speaking both the
languages?

a) 23:25

b) 12:25 !
c) 12:13 {
d) 25:13

Logical Reasoning

26.Five boys A, B, C, D and E are standing
in a row, D is on the right of E. B is on
the left of E, but on the right of A, B is 0"

the immediate left of C, who is standing
in the middle?

a) B ©.
HC g BT
c) D :

d) E

C
27.A, B, C and D are playing cards. A and
and B and D are partners. D is to th

4
AL LY ssTN/Eng/® ‘
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right of C. The face of C is towards west.

LD Find the direction that D is facing.
c 7\West
2~ ) East
9 c) South
d) North

28.1f it was Saturday on December 17,

1899, then what will be the day on . V)
December 22,1901? e I
a) Friday 4§D A RON
b) Saturday " @ (\N(@\ K ’@
«€) Sunday = \(fc\ A A
d) Monday //:,ﬂw j’ f\f
29.Which of the following is a leap year?

2800
b) 1800
c) 2600
.d) 3000

30.The missing number in the series 40,
120, 6Q,/180, 90, ?, 135 is:
a) 110 7> 7 ~AO |
b)-270
c) 105
d) 210

31.If in a certain code language ‘MIGHT  is
written as ‘GHMT!’ then how will

‘EARTH' is written in that cod\ei? . .
TEHA \ S

b) RTEAM 4 \\,?o% e,

¢) RTAEH “

d) RETHA

32.In the given code, SISTEd is coded as
535301, UNCLE as 84670 and Boy as
129. How is RUSTIC written in that
code?
a) 633185 \

\b)~185336

c) 363815
d) 581363

33.Given that in a code language, ‘645’
means ‘M_\A@Lm', ‘43’ means ‘warm
spring’ and ‘638’ means ‘spring is

sunny’, which digit represents ‘sunny? @ A
4O

G5 b
T A "

LA 8
b) 2
c) 4
d) 5

@A girl introduced a boy as the son of the

only daughter of the father of her
maternal uncle. The boy is related to the

girl as: —— 1\
a) Brother D\“Q Ei
b) Uncle

c) Nephew Q ‘/7©
d) Son &

* 35. Ashok started walking towards North.

After walking 30m, he turned towards left
and walked 40m. He then turned left and
walked 30m. He again turned left and
walked 50m. How far is he from his

original position? K
\ay10m 1N

b) 40 m 0

c; 30m 5 %

d)-20m Y ¥

36.A boat moves from a jetty towards East.
After sailing for 9 nautical miles, turns
towards right and covers another 12 NM.
If the boat wants to go back to the jetty,
what is the shortest distance now from

her present position? ~
a) 21 NM " \L\ﬁ
b) 20 NM

c) 18 NM B

4y 15 NM

37.Six persons A, B, C, D, E and F are
standing in a circle. B is between F and
C, Ais between E and D, Fis to the left
of D. who is between

a) B e D
b) C v Al
et f
E
€

38.Replace the question mark (?)in the
following series with suitable option.
C-3,E-5,G-7,1-9, 7,7
a) M-18, K-14
2 JSTN/Eng/B-5
&7
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ot

b

b) K-11, M-13
2 Xza w21
d) 0-15, X-24

39. Choose the odd word in the group.
a) Peacock
b) Vulture
c) Sparrow

t99/ Swan

40.A person walks towards his house at
8:00 am and observes his shadow to his
right. In which direction he is walking?
a) North

b) South
o) East ¢
d) West -
41.If the proposition ‘All thieve oor’ is

false, which of the following propositions
can be claimed certainly to be true?

Propositions:
)

.2y Some thieves are poor
b) Some thieves are not poor
s
>

c) No thief is poor
d) No poor person is a thief

42.\What will be the angle between hour
hand and minute hand, if clock shows

8:30 PM? %
a) 90° “\‘
by 75° . ) ‘ﬁ]fo

c) 60° (i \}.5
d) 85 \» 4

43.1n the following figure given numbers
indicate Indian, leader and singer. Study
the figure carefully. Which region among
them denotes Indian leaders who are not
singers. Indicate that number.

=&

Singer

Leader

a3z
b)3 3
C)4 A\C/i
d)5 -
) RN
44, IfA means "+, B means - *, C meang
', then find the value of fo|l0wmg
equahon
46A2B3C4 =7
a) 34 py1-> ™
b) 23 B
c) 17 5% 1)
a1 W % 5\

45.Which of the following expressions wil|
be true, if the given expression K= G >
H < F is definitely true? T
a) F2K 3 =
PoHeke  ezWT
wc) F<G
~d) Kz2H
46.Which of the following is correct about
the given diagram?

)

"a) AlRare T"
b) All P are T~
c) AlTarePv "
d) AllP are R}

. Which year will have the same calendar
as that of 20127
a) 2020
b) 2040
c) 2025
d) 2031

48.What was the day of the week on 4th
June, 20227 42 9\,“
a) Tuesday q W

g)/Monday JSTN/Eng/B
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c) Friday
d) Saturday

x (@A B, C, D and E belong to five different
cities P, Q, R, S and T (not necessarily in
that order). Each one of them comes
from a different city. Further it is given
that

|. B and C do not belong to Q

II. B and E do not belong to P and R

Il. A and C do not belongto R, Sand T
IV. D and E do not belongto Qand T
Which one of the following statements is
not correct?

a) C belongstoP

b) D belongs to R

c) Abelongsto Q

d) BbelongstoS

|\ &

}c@. How many triangles are there in the
following figure?

-

. N
oM

a) 16
sb) 20
c) 12
d) 22

51. One writes all numbers from 50 to 99 without
the digits 2 and 7. How many umbers have

been written? s g
332 Sy .
b) 36 W Bl
c) 40 AR
d) 38 \'“ % T
"y

52. |f B=2, BAG=10, then BOX=? %“x
"

a) 36
b) 39 L
d) 52

53. 12 monkeys can eat 12 bananas in 12
minutes. In how many minutes can 4
monkeys eat 4 bananas?

)

N2 o
\/\%/’ /

YL

a) 10 min
b) 4 min
c) 8 min

_ )12 min

54. In a post office, stamps of three different
denominations of Rs 7, Rs 8 and Rs 1Q are
available. The exact amount for which one
cannot buy stamps is:

F

a) Rs19 g ¢ \O

b) Rs 20 o \®

c) Rs23 i T

d) Rs 29 DA 4

55. Five children take part in a tournament.
Each one has to play every other one. How

many games must they play? »
a) 8 A\ G«
be 10 « g‘f\')( % Y
24 G - S _ws
C) 7 G\’ v
d) 30 $r

Current Affairs

@. What is the name of new law replacing Indian
Penal Code? A ,
a) Bharatiya Nagarik Suraksha Sanhita
Raratiya Nyaya Sanhita
'c) Bharatiya Sakshya Adhiniyam
d) Bharatiya Danda Sanhita -

57. In which countfy did a powerful earthquake
(7.6 cm on Richter scale) erupt in first week of
January, 20247

a) Turkey
apan

¢) Indonesia

d) Palestine

58. Who is the. Minister for “SC & ST
Development, Minorities & Backward classes
welfare” in Govt. of Odisha?

Maganath Saraka
b) Shri Sudam Marandi
c) Shri Niranjan Pujari
d) Smt. Usha Devi

59 Which was the closing fim of 54"

International Film festival of India?

a) About Dry Grasses
oY The Featherweight
c) Catching Dust

d) Barbie
JSTN/Eng/B-7
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60. Who is the Chief of Army staff of Indian
Army?
a) General M.M Narvane
. eneral Manoj Pande
c) General Bikram Singh
d) General Dalbir Singh Suhag

61. Who is author of book “KNIFE" (to be
published in early 2024)

a) Mr. Sashi Tharoor
b) Mr. Amitabh Ghosh

LS Mr Salman Rushdie

d) Ms.Arundhati Roy

62. Ustad Rasid Khan died recently. In what field
did he achieve his fame?

Msic
b) Dance
c) Literature

d) Sports

63. Houthis have been carrying out attacks on
commercial shipping in Red Sea (December
2023/January 2024). In which country do they

control territory?

a)-Yemen
b) Oman
c) Lebanon

>yfﬁ'an
64. Which among the following countries did not
have general election in January 2024 ?

a) Bangladesh
b) Bhutan
c) Taiwan

gy Pakistan

65. During crocodile census in Bhitarkanika in
2023, how many saltwater crocodiles were

found?

i+
1793
c) 2793
d) 3793

66. Where was COP-28 (Climate change
Conference) held?

\,aa/szbai

b) Azerbaijan

«¢) Egypt (Sharm-Al- Seikh)
d) VK (G|asgow)
hich Court Ruled (in late December_2023)

67. W
ump’'s name can’t be on Ballot?

that Donald Tr

a) Colorado Supreme Court
.S Supreme Court

c) Maine Trial Court
d) Arizona High Court

68. Who is the new Chief Minister of Mizoram?

r. Lalduhoma
b) Mr. Zoramthanga
c) Mr. Lal Thanhawla

d) Mr. Laldenga

69. Who was recently appointed Prime Minister

of New Zealand? (

Mr. Christopher Luxon
b) Mr. Chris Hipkins
c) Mr. Winston Peters
d) Mr. Jacinda Ardern

70. Who has been selected for Kendra Sahitya
Akademy award in Odia Literature for 20237

a) Sri Yasodhara Mishra
b)Y-Sri Ashutosh Parida

c) Sri Hrushikesh Mallick
d) Smt. Paramita Satpathy

@ Who is India’s Ambassador To USA?

a) Shri Navtej Sarna
b) Shri S. Jaishankar

+_c)~Shfi Taranjit Singh Sandhu
d) Shri Harsh Vardhan Shringala ]

72. Who is the Chief Minister of Telangana ? E

a) Shri K Srihari

ri A Revanth Reddy
c) Shri K Chandrasekhar Rao
d) Shri B. Vikramarka Mallu

73. What does BSKY stand for?

ijlu Swasthya Kalyan Yojna
b) Biju Swachh Kalyan Jojana
c) Biju Samast Kalyan Yojana
d) Biju Sangeet Kalyan Yojana

74. Who is Mr. Rahul Narwekar?

\?/Sf)eaker of Maharastra

JSTN/Eng/B-8
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b) Deputy Chief Minister of Maharastra
c) Governor of Maharastra
d) Home Minister of Maharastra

rector of FBI visited India in December
nd met CBI & NIA Chief, among others.
esent Director of FBI.

75. Di
2023 a
Name the P

a) J. Edgar Hoover
hristopher A. Wray

c) James B Comey

d) Robert S. Muller

@. What is AMA Bank?

anking  Services in @ Grama
panchayats in Odisha /

b) Name of a new Private Sector Bank -

c) Name of a new Public Sector Bank
_d) None of the above

a

77. Who has been named person of Year-2023
by “Time” magazine?

a) Mr._Jee Biden

r. Taylor Swift
o) Mr. Narendra Modi
d) Mr. Vladmir Putin

A 43, As in January-2023 which among the
following countries does not allow Visa free

travel to Indians?

a) SrilLanka .
b) Malaysia
c) lran -
d)Myanmar

79. First world Odia Language conference is
scheduled to be held from Feb. 3 to Feb. 5,2024
in Bhubaneswar. What is the Tagline of its Logo?

a) Language is the future

b) Promote Mother tongue
.oy Promote Odia Language

d) Peace through Language

80. Where was Kalinga Super Cup held in Jan-
20247

Wga Stadium, Bhubaneswar
) Barbati Stadium, Cuttack
c) National Stadium, New Delhi
d) Rabindra Sarobar Stadium, Kolkata

81. Who was recently sworn in as Prime Minister
of France? .

a) Mr. Laurent Fablus
_byMr. Gabriel Attal

c) Mr. Elisabeth Borne

d) Mr. Jean Castex

82. What is the name of satellite launched in
space by ISRO recently for observing sun?

Wya-u

) Aditya-M1

C) Chandrayan-3
d) EOS-7

83. According to IMD, with respect to India,
which of the following statements is true about
Year 2023 (reference1901-2023)) in terms of

heat?

Y’ Warmest year on record
b) Second warmest year on record

c) Coldestyearon record
d) Second coldest year on record

- 84. Which film was awarded golden peacock at
54t International Film Festival of India?

a) Ih electric Dreams
\p}/ﬁ?;lfss Boarders

c) Ring Wandering

d) Intothe Darkness

85. Who received Satyajit Roy Lifetime
achievement Award at 54th |nternational Film

Festival of India?

Wel Douglas

b) Carlos Saura
“¢) lIstvan Szabo
d) Martin Scorsese

86. Which country has moved International
Court of Justice (ICJ) against Israel alleging
Gaza operations amount to genocide?

outh Africa

«c)-Jordan
d) Saudi Arab

87. Which city emerged at top in Swachha
Bharat Ranking, 20237

ndore
b) Bhubaneswar
c) Navi Mumbai
d) Bhopal

JSTN/Eng/B-9
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88. On which day is Netaji Subash Chandra 94.Which of the following options is used tq
undo the last action in MS Word?

Bose Jayanti observed?

January 23 L8)Ctrl + Z
b) January 22 by Ctrl + Y
c) January 24 ¢) Ctrl + X
d) January 25 d) Ctrl + U
89. Where was the Annual meeting of World 95.Which ribbon tab contains the options for
Economic Forum conducted from 15th -19th \%,arzj%ing the paragraph line spacing in Ms
January, 20247 ord”
Home
"Doha
@B; Dubai b) Insert
0S c) Page Layout
g) Denver d) References

90. Lanjia Saura paintings, which recently got 15:96.:/Vha't is N}ge V\f/li)r:gt’;on of the Thesaurus
Gl tag, be'ong to which state? eature in .
a) To translate text into different languages

West B I
2) déhaenga bY To find synonyms and antonyms of words
c) Jharkhand c) To change font styles
d) Bihar d) To create hyperlinks
97 .How can you break the current column and
Computer Fundamental and Internet start a new column immediately in MS-Word?
Awareness o’ :
) ress Ctrl + Shift + Enter
91. In MS-WORD, Ctrl + Q is used to: b) Press Alt + Enter
_ . c) Press Ctrl + Enter
a8} "Remove Paragraph formatting (Line d) Press Alt + Shift + Enter
Space and Paragraph Space)
b) Close Word Application without saving . @ A user wishes to remove a spreadsheet
Dc_>cument . from a workbook. Which is the correct
¢) Print Whole Document without sequence of events that will do this?
confirmation e
d) Does nothing a) Go to File-Save As — Save As Type — Excel
. L t Ctrl + F is used to: worksheet
92. In MS-WOBDZZSREC ! C = Bee @ Right click on the spreadsheet tab and select
i lace Dialog box with DELETE
\a}Opgn ,-:md ?nd-:? ebp jjoe Hialog c) Right click on the spreadsheet and select
activalyd RgEE : c Insert — Entire Column
b) Open Page Setup Dialog box with AN £ the ab
activating Layout Tab o ) None of the above
= ‘(:)p ent FS ht Dialog Blex wilhy SRy t o What is represented by the small, black
, ont ta : ) ! e
' d) Open File Save as Dialog box /f square in the lower-right corner of an active cell
or range in MS-Excel?
\ 93. Which of the following options is used to a) Copy handle
‘ create a numbered list in MS Word? b) File handle
a) Ctrl + N c) Insert handle
b) Ctrl + | d) Border
c) Ctrl + U

_dyCtrl + Shift + L

JSTN/Eng/B-10
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n a row of data is to be converted into

gwhe :
gmns in MS-Excel:
the cells in row, select the same

a) COPY f cells in row and paste

) Copy the cells in column then choose Edit >>
gaste special, then click Transpose and OK

opy the cells then go to Format >> Cells

then ON Alignment tab click Transpose check
bOX and CIiCk OK

4) Select the cells then place the cell pointer
on New cell and choose Edit >> Paste Special,
mark Transpose check box and click OK

101.In MS Excel, to hold row and column titles
in places so that they do not scroll when you
scroll a worksheet, click the-

a) Unfreeze panes command on the window

menu
b) Freeze panes command on the window

menu
c) Hold titles command on the edit menu
d) Split command on the window menu

102.Which tool will you use to join some cells
and place the content at the middle of joined
cell in MS Excel?

a) From Format Cells dialog box click on
Merge Cells check box

b) From Format Cells dialog box select the
Centered alignment

¢) From Format Cells dialog box choose
Merge and Center check box

d) Click on Merge and Center tool on
formatting toolbar

n MS-Excel, Long text can be broken
down into many lines within a cell. You can do
this through:

a) Wrap Text in Format > Cells

b) Justify in Edit > Cells

¢) Text Wrapping in Format > Cells
YAl of the above

104.The first cell in EXCEL worksheet is
labelled as: :

a) AA
LrA1

c) Aa
d) A0

105. Which of the cell pointer indicate that you
can move the content to another cell in
EXCEL?

a) Doctor’s symbol (Big Plus)

b) Small thin plus icon

c) Mouse Pointer with anchor at the tip
d)

None of the above

106. In Microsoft PowerPoint to preview a
motion path effect using the custom animation
task pane, you should--

a) click the play button

b) click the show effect button
c) double click the motion path
9YAll of the above

107.Which is the menu command to regolor a
picture on a slide in Microsoft PowerPoint?

..aYInsert -> Picture -> Recolor

b) Tools -> Picture -> Recolor
c) Format -> Picture -> Recolor
d) Edit -> Picture -> Recolor

108. Which command will you use in
PowerPoint if you need to change the color of
different objects without changing content?

a)yDesign Template
b) Color Scheme

c) Font Color
d) Object Color

109.In Microsoft PowerPoint to edit an already
inserted embedded organization chart object:

a) Double Click on the organization chart object

b) CTRL + Click on the organization chart
object

c) SHIFT + Click on the organization chart
object

d) None of the above

110.How to change the order of Slides in
Presentation?

a) On Slide Sorter View click on the Soft
Slides
«0)"On Slide Sorter View click on the slide
and drag to required position
c¢) On Slide Thumbnail view click on the

slide and drag to required position
JSTN/Eng/B-11
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d) Slides order cannot be changed once it
created

111.How to show the same presentation
continuously in Microsoft PowerPoint?

. 8) by enabling the option “Loop

continuously until ‘Esc”

b) by enabling the option “Repeat
Presentation”

c) by enabling the option “Show same
Presentation”

d) Presentation cannot be continue once it
finished

112. Which of the following feature allows you
to select more than one slide in slide sorter
view in Microsoft PowerPoint?

a) Alt + Click each slide

b) Shift + drag each slide

c) Shift + Click each slide
«d)Ctrl + Click each slide

113.In MS-Access Cascade delete option-

a) is used to delete all the records of all tables
in a database

b) will repeat the recent delete operation to all
the records of current table

c) is available in Edit relationship dialog box
which makes sure that all the related records
will be deleted automatically when the record
from parent table is deleted

d) None of above

114 What happens when you release mouse
pointer after you drop the primary key of a table
into foreign key of another table?

a) A relationship is created

b) Edit relationship dialog box appears
c) Error occurs '
d) Nothing happens

115. How can you define a field so that when
entering data for that field it will display e
instead of actual typed text in MS-Access?

a) Input mask

b) Validation Rule
c) Indexed

d) IME Mode

116. A cookie:
\9)/Stores information about the user's web
activity

b) Stores software developed by the usg,
c) Stores the password of the user
d) Stores the commands used by the use,

(1{17/ In MS-Access to create relationship
between two tables:

a) drag the primary key of a table into
foreign key of another table

b) drag the foreign key of a table into the
primary key of another table

c) drag any field from parent table and drop
on child table

d) Any of above can be done to create
relationship

118. Which of the following is used to
summarize data in a table in Microsoft Access?

a) Report

b) Form

cyQuery

d) Table Design View

413 Which of the following is used to create a
pivot table in Microsoft Access?

a) Pivot Table Wizard

b) Pivot Table Design View
c) SQL View

d) All of the above

@Two tables can be linked with relationship
so that the data integrity can be enforced.
Where can you find Relationship Command?

a) Home Tab

b) Create Tab

c) External Data Tab
d) Database Tab

121. A network that is connected to the
Internet, but uses encryption to scramble all the
data sent through the internet is called

a) My network

Virtual Private Network
c) Social Network
d) Internet Service Provider

122. DNS stands for

a) Domain Name Signal
by Domain Name System
c) Domain Name Server
d) Domain Number System
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2 browser, the URL of the current page

3.In
|152d|5p|ayed at
) T oolbar
Address bar
Lc)/ Title bar
d) Mend bar )
124. What is BCC in email? (1’%\ f,)'f> . \/
a) Block content creation ( ( G
b) Behind Content Copy i z/\
c) Blind Carbon Copy \, . & o
Ud) None of these % <O

125.The following message is displayed on the
browser, while trying to access a URL

gerver; Error 403
The reason for the message is:

a) The requested HTML file is not available

b) The URL refers to a CGil script and the
header of the script does not indicate
where the interpreter is located

c) The path to the interpreter of the script

~file is invalid

d) The requested HTML file or CGl script
has insufficient permission

Arithmetic

126. The largest 4 digit number exactly
divisible by 88 is:

a) 9944 —

b) 9768 — -

 )-9988 -~
d)

8888 .

127. The difference of two numbers is 1365.
On dividing the larger number by the
smaller, we get 6 as quotient and the 15 as
remainder. What is the smaller number?

a) 240 -
_bY270 LI

c) 295 @ QT b
d) 360

S

128.107 x 107 + 93x93=2 " @q/

b
) 19578  — N9 g

b) 19418 TP
20098 “T i (90‘

o,

o
N

129. If one-third of one-fourth of a number is
15, then three-tenth of that number is:
a) 35 & R
b) 36 TARYE
% of de ¥ %)
C) 45 0 A A AR
\(D 54 o / /6

130. Which one of the following can't be the
square of natural number?

a) 30976

b) 75625 .’

c) 28561 9
. d) 143642 /

131. The square root of 64009 is:

253 \
b) 347 "I
c) 363 e

d) 803 E% _—a

132. Five bells begin to toll together and toll
respectively at intervals of6,5,7,10and 12
seconds. How many times will they toll
together in one hour excluding the one at.

th(i;ta/rt? -

7 times 9 \0

b) 8times \y’ "G L -
c) 9times A S
d) 11 times 07\[%“ LA

K %

@ If 2994 + 14.5 = 172, then 29.94 + 1.45

! ¥
a) 0.172 %xt S\
c)17.2 ’%’;

d) 172

134. A train 240 m long passes a pole in 24
seconds. How long will it take to pass a
platform 650 m long?

65 sec 40 §GEO
by 89 sec 4/ (S0
c) 100 sec v
d) 150 sec {\ 0

135. A boat running downstream covers a
distance of 16 km in 2 hours while for
covering the same distance upstream, it
takes 4 hours. What is the speed of the boat
in still water?

AW
a) 4.km/hr ™

<P ™M
a ¥

i
2 @q/%)\ 21908 X\SJ“V@\%\ , DEkmbe Y
A N\ w
@ L % SN
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c) 8 km/hr
d) Data inadequate

136. In a 100 m race, Ajay beats Bijay by 10
m and Sujoy by 13 m. In a race of 180 m,

Bijay will beat Sujoy by: -
a) 54m Pl n
b) 4.5m — 4
c) 5m N\ W
\d)

137. At 3:40, the hour hand and the minute
hand of a clock form an angle of:
& 120° 0

130°

d) 135° ‘V\>77\’p,

138. The ratio of the number of boys and
girls in a college is 7:8. If the percentage
increase in the number of boys and girls be
20% and 10% respectively, what will be the

new ratio? g@
a) 8:9 QY N
b) 17 :18 Ny Ve

©)21:22 cé)'\(y\

d) Cannot be determined

139. Anand and Binod started a partnership
business investing some amount in the ratio
of 3:5. Chaitanya joined them after six
months with an amount equal to that of
Binod. In what proportion should the profit at
the end of one year be distributed among
Anand, Binod and Chaitanya? DI

a) 3:5:2 Xy

b) 3:5:5 %

6.:10 46
d) Data inadequate

140. In an election between two candidates,
one got 55% of the total valid votes, 20% of
the votes were invalid. If the total number of
votes was 7500, the number of valid votes
that the other candidate got, was:
_aJ 2700

b) 2900

c) 3000

d) 3100

141. A grocer has a sale of Rs. 6435, Rs.
6927, Rs. 6855, Rs. 7230 and Rs. 6562 for
5 consecutive months. How much sale must

oy
D

m o B, |
6 //)/

v
()7 7
° i{‘ N

]

he have in the sixth month so that he et

an average sale of Rs. 65007
+a)Rs. 4991
b) Rs. 5991
c) Rs. 6001
d) Rs. 6991

142. There is 60% increase in an amoy i
6 years at simple interest. What will be
compound interest of Rs. 12,000 after 3
years at the same rate?

a) Rs. 2160

b) Rs. 3120

\Q/f{s. 3972

d) Rs. 6240

143. A shopkeeper earns a profit of 25% o,
selling a microwave at 15% discount on the
Printed Price. Find the ratio of the Printed
Price and Cost Price of the Microwave.

a) 17:25
b) 25:27
c) 27:25

) 25:17

144. If 6 men and 8 boys can do a piece of
work in 10 days while 26 men and 48 boys
can do the same in 2 days, the time taken
by 15 men and 20 boys in doing the same
type of work will be: '

a)4 days

b) 5 days

c) 6 days

d) 7 days

145. Two pipes A and B together can fill a
cistern in 4 hours. Had they been opened
separately, then B would have taken 6
hours more than A to fill the cistern. How
much time will be taken by A to fill the
cistern separately?

a) 1 hour

b) 2 hours

LeY 6 hours

d) 8 hours

146. A is 3 years older to B and 3 years
younger to C, while B and D are twins. How
many years older is C compared to D?

a) 2

b) 3
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| )/ a) 3500
/ 12 . b) 4000
c) 4050

~d
) qan has some hens and cows. If the
4T A be 48 and the number of d) 5000

per of heads th
”uTe Jals 140, then e number of hens
feé

e
wllI:) 2
p) 23

c) 24
9%
on dividing @ number by 68, we get

1gg.as quotient and 0 as remainder. On
ider?
e rema'nder ’ '
e % Q <

N4l et

9. Two tailors Ahmed and Saddam are
aid a total of Rs. 550 per week by their
employer- If Ahmed is paid 120 percent of
the sum paid to Saddam, how much is

gaddam paid per week?
a) Rs. 200
Rs. 250
c) Rs.300
d) None of these

150. The average monthly incomeé of P and
Qis Rs. 5050. The average monthly income
of @ and R is Rs. 6250 and the average
monthly income of P and R is Rs. 5200. The

monthly income of P
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